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Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) trunking between Swisscom Smart Business Connect and Avaya IP Office with Avaya
Session Border Controller for Enterprise.

Swisscom Smart Business Connect provides PSTN access via a SIP Trunk connected to the
Swisscom Voice over Internet Protocol (VolP) network as an alternative to legacy analogue or
digital trunks. Swisscom is a member of the Avaya DevConnect Service Provider program.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) trunking between Swisscom Smart Business Connect and Avaya IP Office with Avaya
Session Border Controller for Enterprise (Avaya SBCE). Customers using this Avaya SIP-
enabled enterprise solution with Swisscom’s SIP Trunk are able to place and receive PSTN calls
via a dedicated Internet connection and the SIP protocol. This converged network solution is an
alternative to traditional PSTN trunks. This approach generally results in lower cost for the
enterprise customer.

2. General Test Approach and Test Results

The general test approach was to configure a simulated enterprise site using Avaya IP Office and
Avaya SBCE to connect to the Swisscom Smart Business Connect SIP trunk. This configuration
(shown in Figure 1) was used to exercise the features and functionality listed in Section 2.1.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent
to the interoperability of the tested products and their functionalities. DevConnect Compliance
Testing is not intended to substitute full product performance or feature testing performed by
DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or
completeness of a DevConnect member’s solution.

Avaya recommends our customers implement Avaya solutions using appropriate security and
encryption capabilities enabled by our products. The testing referenced in these DevConnect
Application Notes included the enablement of supported encryption capabilities in the Avaya
products. Readers should consult the appropriate Avaya product documentation for further
information regarding security and encryption capabilities supported by those Avaya products.

Support for these security and encryption capabilities in any non-Avaya solution component is
the responsibility of each individual vendor. Readers should consult the appropriate vendor-
supplied product documentation for more information regarding those products.

2.1. Interoperability Compliance Testing

Avaya IP Office was connected to the Swisscom Smart Business Connect SIP trunk via the
Avaya SBCE and a VPN established over the internet.
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To verify SIP trunking interoperability the following features and functionality were exercised
during the interoperability compliance test:

Incoming PSTN calls to various phone types including H.323, SIP and analogue
telephones at the enterprise. Calls routed to the enterprise via the SIP trunk from
Swisscom.

Outgoing PSTN calls from various phone types including H.323, SIP and analogue
telephones at the enterprise. Calls routed from the enterprise via the SIP trunk to
Swisscom.

Inbound and outbound PSTN calls to/from an Avaya Communicator for Windows client.
Various call types including: local, international, toll free (outbound) and directory
assistance.

Calls using G.711A, G.711MU and G.729A codec’s.

Caller ID presentation and Caller ID restriction.

DTMF transmission using RFC 2833.

Voicemail navigation for inbound and outbound calls.

User features such as hold and resume, transfer, and conference.

Off-net call forwarding and mobile twinning.

2.2. Test Results

Interoperability testing of the sample configuration was completed with successful results for the
Swisscom Smart Business Connect. The following observations were made during the test:

When making an outbound call to an invalid number, the network sent 200 OK (Answer)
before playing an announcement. The behaviour more commonly observed is for a
backwards transmission path established using SIP 183 Session Progress to be used to
play a tone or announcement to the caller. Using 200 OK completes the SIP dialogue and
establishes the call making it indistinguishable from a successful call.

When making some outbound calls, in particular calls to mobile phones, an UPDATE
message was received from the network within the initial INVITE dialogue that reversed
the From and To headers. IP Office rejected these with “500 Internal Server Error”. This
did not adversely affect call set-up.

Emergency Calls to a test number were attempted and the location data could be seen in
the body of the initial INVITE message in xml format. These calls were not answered.
When putting inbound calls on hold for over 15 minutes, the outbound audio was lost
when the call was taken off hold. This fault was intermittent and disappeared altogether
when encryption between the IP Office and the Avaya SBCE was removed. This is
assumed to be related to an existing issue on the Avaya SBCE, raised as fault report
AURORA-12076, with conversion between encrypted and unencrypted media.

When putting outbound calls on hold for over 15 minutes, calls were released from the
network. This was resolved by changing the configuration of the IP Office so that call
hold was not indicated by the use of re-INVITE messages.

There were a small number of instances where although an outbound test call was
answered, there was no 200 OK message received from the network. This was assumed
to be an issue in the test environment and not a SIP interoperability issue.
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2.3. Features Not Tested

The following features and functionality were not tested:
e No inbound toll-free access was available for testing
e Emergency Calls were not tested as the IP Office location data was not defined.
e Fax testing was not required as this is not offered to Swisscom customers on IP Office.
Although not required, some fax calls were attempted but these failed.
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2.4. Support

For technical support on the Avaya products described in these Application Notes visit
http://support.avaya.com.

For technical support on Swisscom products please contact the Swisscom support team: Email:
cbu.incident-voice@swisscom.com.
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3. Reference Configuration

Figure 1 illustrates the test configuration. The test configuration shows an enterprise site
connected to Swisscom Smart Business Connect. Located at the enterprise site are an Avaya IP
Office Server Edition and an Avaya IP Office 500 v2 as an Expansion. Endpoints include an
Avaya 1600 Series IP Telephone (with H.323 firmware), Avaya 9600 Series IP Telephones (with
H.323 firmware), an Avaya 1140e SIP Telephone and an Avaya Analogue Telephone. The site
also has a Windows 7 PC running Avaya IP Office Manager to configure the Avaya IP Office as
well as Avaya Communicator for Windows for mobility testing. For security purposes, PSTN
routable phone numbers used in the compliance test are not shown in full.
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Figure 1: Swisscom Smart Business Connect to Avaya IP Office via Avaya SBCE Topology
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4. Equipment and Software Validated
The following equipment and software were used for the sample configuration provided:

Equipment/Software | Release/Version
Avaya

Avaya IP Office Server Edition 10.1.0.0.0 build 237
Avaya IP Office 500 V2 Expansion 10.1.0.0.0 build 237
Avaya 1140e IP SIP Telephone 04.04.23.00

Avaya 1608 IP Phone (H.323) 1.350B

Avaya 9611 IP Phone (H.323) 6.6.4.01

Avaya 98390 Analogue Phone N/A

Avaya Communicator for Windows 2.1.4.0

Avaya IP Office Server Edition Manager Version 10.1.0.0.0 build 237
Swisscom Smart Business Connect

Cisco C881-K9 Integrated Services Router | 10S 15.6

Testing was performed with IP Office Server Edition with 500 V2 Expansion R10.1. Compliance
Testing is applicable when the tested solution is deployed with a standalone IP Office 500 V2
and also when deployed with all configurations of IP Office Server Edition. Note that IP Office
Server Edition requires an Expansion IP Office 500 V2 to support analog or digital endpoints or
trunks.

BG; Reviewed: Solution & Interoperability Test Lab Application Notes 7 of 64
SPOC 2/6/2018 ©2018 Avaya Inc. All Rights Reserved. SSBC_IPO101_SBC



5. Configure Avaya IP Office

This section describes the Avaya IP Office configuration to support connectivity to Swisscom
Smart Business Connect. Avaya IP Office is configured through the Avaya IP Office Manager
PC application. From a PC running the Avaya IP Office Manager application, select Start >
Programs - IP Office - Manager to launch the application. Navigate to File > Open
Configuration (not shown), select the appropriate Avaya IP Office system from the pop-up
window and log in with the appropriate credentials. A management window will appear similar
to the one in the next section. All the Avaya IP Office configurable components are shown in the
left pane known as the Navigation Pane. The pane on the right is the Details Pane. These panes
will be referenced throughout the Avaya IP Office configuration. All licensing and feature
configuration that is not directly related to the interface with the Service Provider (such as
mobile twinning) is assumed to already be in place.

-
f Select IP Office = B =

MName IP Address  Type Version Edition
Server Edition 10.1
ipol00sery 10104101 IPO-Linux-PC  10.1.0.0.0 build 237  Server (Primary) Select

Canfiguration Service User Login
IP Office: ipol00sery (Primary System - IPO-Linux-PC)
Service User Name Administrator
Service User Password  essssssss
[ oK l ’ Cancel ] [ Help

TCP Discovery Progress

Open with Server

Unit/Broadcast Address Edition Manager
10104101 - oK ] [ Cancel
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5.1. Verify System Capacity

Navigate to License in the Navigation Pane. In the Details Pane verify that the License Status
for SIP Trunk Channels is Valid and that the number of Instances is sufficient to support the
number of channels provisioned for the SIP trunk.

File Edit View Tools Help
254 AEEW v
Configuration | [ v <>
- #& BOOTP (9) Licence | Remote Server
Hg Operator (3) P - -
=43¢ Solution
%% g::[fsg] Feature Instances Status Expiry Date Source i Add...
- @% Short Code[45) Receptionist 10 Walid 14/03/2018 PLDS Modal
m Directory(0) Additional Veicemail Pro Ports 252 Walid 14/03/2018 PLDS Medal
1) Time Profile() VMPro Recordings Administrators 1 Valid 14/03/2018 PLDS Modal
;; ﬁ::f;'i”gthffgfm Office Worker 1000 Valid 14/03/2018 PLDS Nodal
é Location(0) VMPro TTS Professional 40 Valid 14/03/2018 PLDS Modal
=% ipcl00serv IPSec Tunnelling 1 Obsolete 14/03/2018 PLDS Medal
(%57 Systemn (1) Power User 1000 Valid 14/03/2018 PLDS Medal =
‘ BT Line (3) Avaya IP endpoints 1000 Valid 14/03/2018 PLDS Nodal
E e E};::j'og’at] t SIP Trunk Channels 256 Valid 14/03/2018 PLDS Nodal
| w-§ User(s) IP500 Universal PRI (Additional cha... 100 Obsolete 14/03/2018 PLDS Medal |
i Group (1) CTILink Pro 1 Valid 14/03/2018 PLDS Modal 1
(#-@% Short Code (53) Wave User 16 Obsolete 14/03/2018 PLDS Medal
@ Service (0) 3rd Party IP Endpoints 1000 Valid 14/03/2018 PLDS Medal
I 49 Incoming Call Route (4) Server Edition R10 150 Valid 14/03/2018 PLDS Nodal -
| ::::;_ $::;t;sz?§ @ UMS Web Services 1000 Valid 14/03/2018 PLDS Modal
E “ TP Route (2) Avaya Mac Softphone 1000 Valid 14/03/2018 PLDS Modal
M Account Code (0) Avaya Softphone Licence 1000 Walid 14/03/2018 PLDS Medal
R Licence (23] SM Trunk Channels 128 Valid 14/03/2018 PLDS Modal i [ 4
[ a 3 User Rights (9) 2

5.2. LAN1

In the sample configuration, the LAN1 port was used to connect the Avaya IP Office to the
Avaya SBCE. Note that this is the local LAN port also used for connection to endpoints. To
access the LANL1 settings, first navigate to System = <IP Office Name> in the Navigation Pane
where <IP Office Name> is the name of the IP Office. This is ipo100serv for the Server Edition
in the GSSCP test environment. Navigate to the LAN1 = LAN Settings tab in the Details Pane.
The IP Address and IP Mask fields are the internal interface of the IP Office. All other
parameters should be set according to customer requirements. On completion, click the OK
button (not shown).

Configuration | = ipo100serv

K BOOTP (9)
Operator (3)

| Systemn | LANL | LAMNZ | DNS | Voicemail | Telephony | Directory Services | Systemn Events | SMTP

7 Solution LAN Settings |VoIP | MNetwork Topology|
m-§ User(34)
- Group(l) IP Address 0 .10 . 4 . 101

(8% Short Code(45)
----- == Directory(0)

£ Time Profile(0)
----- #m Account Code(0)
&-fiy User Rights(9) Number Of DHCP IP Addresses (153

(-8 Location(1)
=437 ipol00serv DHCP Mode

System (1) ©) Server () Client @ Disabled
=/ ipol00servy

-1 Line (2)

1P Mask 255 . 255 . 255 0
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On the VoIP tab in the Details Pane, check the SIP Trunks Enable box to enable the
configuration of SIP trunks. Scroll down for further configuration. Define Keepalives as

required, during testing RTP-RTCP was used with a Periodic Timeout of 5. The RTP Port

Number Range can be customized to a specific range of receive ports for the RTP media. Based
on this setting, Avaya IP Office requests RTP media to be sent to a UDP port in the configurable
range for calls using LANZ2. The range used for testing was the Linux default setting of 40750 to

50750.
| System | LANL | LAN2 | DMS | Voicemail | Telephony | Directory Services | Systemn Events | SMTP | SMDR | VolP | VolP Security | Contact Center|
LAM Settings | VoIP | Network Topolog}r|
H323 Gatekeeper Enable
7] Auto-create Extn Auto-create User ] H323 Remote Extn Enable
H.323 Signalling over TLS Disabled - 1720
SIP Trunks Enable
SIP Registrar Enable
[[] Auto-create Extn/User [T] SIP Remote Extn Enable
SIP Domain Mame gvaya.com
SIP Registrar FQDM ipol00serv.avaya.com
upp UDP Port 3060 = 5060
Layer 4 Protocol TCP TCP Port 5060 = 5060
TLS TLS Port (5061 = 5061
Challenge Expiry Time (secs) 10 =
RTP
Port Mumber Range
Minirnum 40750 = Maxirnum 50750
Port Mumber Range (MAT)
Minimum 40750 = Maximum 50750
Enable RTCP Monitering on Pert 5005
RTCP collector IP address for phones 0 0
Keepalives
Scope \RTP-RTCP = | Pericdic timeout 5
Initial keepalives lEnabIed vl
DiffServ Settings
B8 [ DSCP(Heq B8 |2 Video DSCP(Hex) FC [ DSCP Mask (Hex) 88 2| SIG DSCP (Hex)
46 |5 DscP 46 2| Video DSCP 63 2 DSCPMask 34 2 SIGDSCP
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Note: Avaya IP Office can also be configured to mark the Differentiated Services Code Point
(DSCP) in the IP header with specific values to support Quality of Services policies for both
signalling and media (not shown). DSCP for media can be set for both voice and video. The
DSCP field is the value used for voice and the SIG DSCP is the value used for signalling. For
the compliance test, the DSCP values were left at their default values.

All other parameters should be set according to customer requirements. On completion, click the
OK button (not shown).

On the Network Topology tab in the Details Pane, leave the STUN Server Address blank and
the Firewall/NAT Type at Open Internet as NAT is not required in this configuration.

The Network Topology tab can be used to set the Binding Refresh Time for the periodic
sending of OPTIONS. This is intended for use where OPTIONS are required at intervals of less
than 300 seconds. A value of 0 uses the default of 300 seconds.

Systern | LAML | LAN2 | DNS Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR | VoIP VolP Security | Contact Center
LAN Settings | VoIP | Metwork Topalogy

Metwork Topology Discovery

STUN Server Address STUN Port 3478 =

Firewall/NAT Type Open Internet hd

Binding Refresh Time (seconds) 0 =
Public IP Address 0 0 0 0 Run STUM Cancel
Public Port

UDP 0

TCP 0

B G ED G RIEL

TLS 0

Run STUN on startup

Note: During compliance testing, registration was used with REGISTER messages sent by the
Avaya SBCE as described in Section 6.6. These REGISTER messages act as a check of the SIP
Trunk so that OPTIONS messages are not critical.
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5.3. System Telephony Settings

Navigate to the Telephony - Telephony tab on the Details Pane. Choose the Companding
Law typical for the enterprise location. For Europe, A-Law is used. Uncheck the Inhibit Off-
Switch Forward/Transfer box to allow call forwarding and call transfer to the PSTN via the
Service Provider across the SIP trunk. On completion, click the OK button (not shown).

| System | LANL | LANZ | DS | Voicemail | Telephany |Directory Services | System Eventsl SMTP | SMDR |VoIP |VoIP Security | Contact 'Center|

Telephony | Park & Pagel Tones & Musicl Ring Tones | 5M | Call Log | TUI |

Dial Delay Time (secs) 1 = Companding Law
— Switch Line
Dial Delay Count 4 -
Default Mo Answer Time (secs) 15 = @ U-Law U-Law Line
Haold Timeout (secs) 3600 =
= @ A-law @ A-Law Line
Park Timeout (secs) 300 =
Ring Delay (secs) 5 = —
atus
Call Priority Promotion Time (secs) |Disabled 2
Auto Held
Default Currency ICHF v] Dial B
ial By Mame
Default Name Priority [Favour Trunk v] Show A  Cod
ow Account Code
Media Connection Preservation ’Disabled vl “:‘ Inhibit Off-Smitch Formard/ Tranefer
Phone Failback ’Automatlc vl [] Restrict Network Interconnect

Login Code Complexity

Include lecation specific information
Enforcement

Drop External Only Impromptu Conference

Minirmum length 4 =
Complexity ] Visually Differentiate External Call
High Quality Conferencing
RTCP Collector Configuration Directory Overrides Barring

Send RTCP t RTCP Collect
[ Sen ean pliector [] Advertise Callee State To Internal Callers

[ Internal Ring on Transfer
5005

BG; Reviewed: Solution & Interoperability Test Lab Application Notes 12 of 64
SPOC 2/6/2018 ©2018 Avaya Inc. All Rights Reserved. SSBC_IPO101_SBC



5.4. Codec Settings

Navigate to the VoIP tab on the Details Pane. Check the Available Codecs boxes as required for
the IP endpoints. Note that G.711 ULAW 64K and G.711 ALAW 64K are greyed out and
always available. Once available codecs are selected, they can be used or unused by using the
horizontal arrows as required. Note that in test G.711 ALAW 64K, G.711 ULAW 64K and
G.729(a) 8K CS-ACELP were used as the default codec’s. The order of priority can be changed
using the vertical arrows. On completion, click the OK button (not shown).

| System | LANL | LAN2 | DNS | Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR | VoIP [

Ignore DTMF Mismatch For Phones |
Allow Direct Media Within NAT Location [

RFC2833 Default Payload 101 =
Available Codecs Default Codec Selection
Unused Selected
G711 ULAW G4E 3,722 64K x> 5,711 ALAW B4KE
G.711 ALAW 64K G711 ULAW 64K
3.722 64K (3.729(a) 8K CS-ACELP

G.729(a) 8K C5-ACELP

AL

>

Note: The codec settings for IP endpoints can also be used for the SIP Trunk by selecting
System Default in the Codec Selection as shown in Section 5.6.2.

5.5. VoIP Security

Avaya recommends our customers implement Avaya solutions using appropriate security and
encryption capabilities enabled by our products. To enable secure media using SRTP, navigate to
the VolP Security tab on the Details Pane. Select the required level of security in the Media
dropdown menu, in the test environment Preferred was selected.

Selecting Preferred allows further configuration of media security. In the test environment,
Encryption and Authentication was applied to RTP. The SRTP Window Size was left at the
default value of 64 and in the Crypto Suites box, only SRT_AES CM_128 SHA1 80 was
selected. These settings only applied within the enterprise, VolIP Security was not used on the
SIP Trunk to the Avaya SBCE due to an issue described in Section 2.2.
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VoIP Security is set according to customer requirements; the example shows the Lab settings:

System | LANL | LAN2 | DNS | Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR | volp | VoIP Security

Media |Preferred - | Strict SIPS

Media Security Options

Encryptions 7| RTP
RTCP

Authentication ¥| RTP
RTCP

Replay Protection

SRTP Window Size 64

Crypto Suites
| SRTP_AES_CM_128_SHAL &0
SRTP_AES_CM_128_SHA1 32

5.6. Administer SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and Swisscom
Smart Business Connect via the Avaya SBCE. The recommended method for configuring a SIP
Line is to use the template associated with these Application Notes. The template is an .xml file
that can be used by IP Office Manager to create a SIP Line. Follow the steps in Section 5.6.1 to
create the SIP Line from the template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

IP addresses.

SIP Credentials (if applicable.)

SIP URI entries.

Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary
after the SIP Line is created via the template. The resulting SIP Line data can be verified against
the manual configuration shown in Section 5.6.2.

Also, the following SIP Line settings are not supported on Basic Edition:
e SIP Line — Originator number for forwarded and twinning calls
e Transport — Second Explicit DNS Server
e SIP Credentials — Registration Required

Alternatively, a SIP Line can be created manually. To do so, right-click Line in the Navigation
Pane and select New=>SIP Line (not shown). Then, follow the steps outlined in Section 5.6.2.
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5.6.1. SIP Line From Template
Copy the template file to the computer where IP Office Manager is installed. The template can
be used in one of two ways: import it and select directly as an option when creating the SIP Line;
create the SIP Line from the template as a file on the local machine. To import the file, click on
the Tools tab and select Import Templates in Manager.

File Edit View | Tools | Help
Conﬁgum1 Extension Renumber...
Export

=& BOOTP (9)
H-¢# Operator (3)
=557 Solution

g User(34)
-1 Group(l)
9% Short Codef(:
- Directony(0)

-l Account Co

- Time Profilg

Server Edition Service User Management
Busy on Held Validation

MSM Configuration
Print Button Labels

Lo [

v Swiss_SBC_IPO10-1
App_Motes
Config

Location_Fault

Browse For Folder X
Select a folder to import templates from -
~

Date created: 04/12/2017 15:47

Import Templates in Manager

Path: Config (C:\Users\wgleeson\Docurnents) Test Swiss_!

- Location(0)
=427 ipol00sery

-f3 User Rights(b

[#-%20 System (1)

Licence Migration

Traces

UPDATE_Fault

Location

Swiss_SBC_IPO101_ASBCE o,

Cancel

To create the SIP Trunk from the template, right-click on Line in the Navigation Pane, then
navigate to New from Template. If the template file was imported as shown above, select it

directly:
%% ipoll .
-9 Sy Mew
=19 Lin
ey, & Cut Ctrl+ X 9
i ! ::‘-L B3 Copy Ctrl+C a0
Gl Ext Paste Ctrl+V 300
Eﬂ---a Us{ 25 Delete Ctrl+Del
""" WG validate 41
=-8% Sh .
..... B Ser‘ Mew from Template SSBC_IPO101_SBC.xml || =
- Ing Export as Template i
..... @ Direcrory o) crescrTprEroY Open from file
----- £ Time Profile (0)
Alternatively, if the template file was not imported, select Open from file.
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Browse to the appropriate folder on the local machine and select Template Files (*.xml) from
the drop down menu:

[ ], « MyDocuments » Tests » Swisscom_SBC_IPO101_ASBCE » Config

- ==

Organize ¥ New folder =~ 0 @

o

.. Swisscom_IPO10

Documents library
. Swisscom_IPO10_

Arrange by: Folder ¥

Config
1 Swisscom_SBC_IF 5
|, Swisscom_SBC_IF Name Date modified Type Size
1 Config | $SBC_IPO101_SBC 04/12/2017 11:09 XML Document 4 KB

I Screenshots Type: XML Document

I Traces E Size: 3.84 KB
& Bae ‘= Date modified: 04/12/2017 11:09

File name: 7 v [Template Files (*xml) v]

[ Open |v] [ Cancel l i

= =

The SIP Line is automatically created and can be verified and edited as required using the
configuration described in Section 5.6.2.
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5.6.2. Manual SIP Line Configuration

To create a SIP Line or to modify a SIP Line previously created from the template, navigate to
Line in the Navigation Pane. Right click on Line and select New (not shown) or select a SIP
Line previously created. On the SIP Line tab in the Details Pane, configure the parameters
below to connect to the Avaya SBCE.

e Set Prefix to the digit, if any, used to access an outside line. In the test environment, this
was 9.

e Set Location to that defined for Emergency calls as described in Section 5.11.

e Set National Prefix to 0 and International Prefix to 00 for number conversion as
follows: outbound national and international called party numbers are converted to E.164
format; inbound national and international calling party numbers are converted to
diallable format. If a prefix digit is used for outbound calls it should be included here.
The example shows 90 and 900 respectively.

e Set Country Code to 41 for Switzerland for number conversion, in conjunction with the
above prefixes, as follows: outbound national called party numbers are converted to
E.164 format using this country code; inbound E.164 calling party numbers are identified
as national numbers using this country code and are converted to national format.

e Ensure the In Service and Check OOS boxes are checked.

e Leave the Refresh Method at the default value of Auto which results in re-INVITE
being used for Session Refresh.

e Leave Timer (seconds) at the default value of On Demand. This value allows the
Session Refresh interval to be set by the network.

e Set Incoming Supervised REFER and Outgoing Supervise REFER to Never. REFER
is not supported by the Swisscom Smart Business Connect

e Leave all other fields at default settings.

Configuration | = SIP Line - Line 2 [ S R S 7
K 80o0TP (9) SIP Line Transpart|SIP URI|VolP | SIP Credentials|SIP Advanced |Engineering
« Operator (3)
= Solution Line Number 2 = In Service v
i User(34)
-4 Group(1) ITSP Domain Name Check 005 v
#-9% Short Code(45)
= Directory(0) Local Demain Name
;T‘ Time Profile(0] Session Timers
81 Account Code(0) URI Type s -]
-y User Rights(@) . Refresh Method Auto -
% i Locstion(l) Location ‘3. Galway v‘
=59 ipol00sery Timer (seconds) On Demand
- System (1)
Line (2)
. 1 Prefix 9
Ty, 2 . .
-2 Control Unit (11) Mational Prefix 90
E:f;’ S‘:ﬁé;’” @ Intemations! Prefix 500
‘i@ Group (0) Country Code 41 Redirect and Transfer
+-8K Short Code (53)
@ Service (0) Name Priority System Default - Incoming Supervised REFER ‘Never v|
P In.(nmmg Call Route (7) . Qutgoing Supervised REFER ‘Ne\rer v|
Directory (0) Description
Time Profile (0) Send 302 Moved Temporarily
1P Route (2) )
Quts Blind REFER
-l Account Code (0) Htgeing B
B Licence (23)

On completion, click the OK button (not shown).
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Select the Transport tab and set the following:

e Set ITSP Proxy Address to the internal IP Address of the Avaya SBCE.

e Set Layer 4 Protocol as required. During testing TCP was used though TLS is
recommended once the RTP to SRTP conversion issue described in Section 2.2 is
resolved.

e Set Send Port and Listen Port as required. During testing, 5060 was used.

e Set Use Network Topology Info to None as NAT is not used in this configuration
the Network Topology settings defined in Section 5.2 are not required.

On completion, click the OK button (not shown).

and

SIP Line Transport |SIP URI|VolP  [SIP Credentials|SIP Advanced |Engineering|

ITSP Proxy Address 10104102

Metwork Configuration

Layer 4 Protocol ITCP v‘ Send Port 5060 =
Use Metwork Topolegy Info INone VI Listen Port 5060 =
Explicit DNS Server(s) 0 0 0 ] 0 0 a a

Calls Route via Registrar

Separate Registrar

After the SIP line parameters are defined, the SIP URIs that Avaya IP Office will receive and
transmit on this line must be created. To create a SIP URI entry, first select the SIP URI tab.

Click the Add button and the New URI area will appear at the bottom of the pane.

»SlP Line]:l'vansport‘ SIP URI ?VoIP . ]SIP CredentialslVSIP Advanced!éngineering‘

URI Groups Local URI Centact Display Name Identity Header Originator Number Send CallerID Diversion Header Credential Max Calls Add...

Remove

A SIP URI is shown in this example that is used for calls to and from extensions that have
number assigned to them. Additional SIP URI’s may be required for calls to services such
Voicemail Collect and the Mobile Twinning FNE, these would be for incoming calls only.
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The SIP URI for calls to and from extensions that have DDI numbers associated with them was
created with the parameters shown below.

Set Local URI, Contact and Display Name to Use Internal Data. On incoming calls,
this will analyse the Request-Line sent by Swisscom and match to the SIP settings in the
User profile as described in Section 5.8. On outgoing calls this will insert the SIP settings
in the User profile into the relevant headers in the SIP messages.

Leave the Originator Number for Forwarding and Twinning blank so that the
originating number is sent as the calling party number. Select Diversion Number as the
Send Caller 1D value to ensure that the DDI number assigned to the forwarding
extension is sent in the Diversion header.

Leave the Registration drop down menu at the default value of 0: <None>. Although
registration and authorisation are used, the function is provided by the Avaya SBCE as
described in Section 6.6.

Associate this line with an incoming line group by entering a line group number in the
Incoming Group field. For the compliance test, a new incoming group 2 was defined
that was associated to a single line (line 2).

Associate this line with an outgoing line group by entering a line group number in the
Outgoing Group field. For the compliance test, a new outgoing group 2 was defined that
was associated to a single line (line 2)

Set Max Sessions to the number of simultaneous SIP calls that are allowed using this SIP
URI pattern.

Leave other fields at default values.

On completion, click the OK button.

Edit URI
Local URI Use Internal Data -
Contact Use Internal Data -
Display Mame Use Internal Data -
Identity
Identity Use Internal Data -
Header P Asserted ID -

Forwarding And Twinning

Criginator
MNurmber
send Caller Id Diversion Header hd
Diversion Header MNone -
Registration 0: <Mone> hd
Incoming Group 2 -
Outgeing Group 2 -
Max Sessions 10 =
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Note: If required a SIP URI can be created for calls to services such as Voicemail Collect and
the Mobile Twinning FNE: The numbers used for these services may not be associated with a
User so the incoming calls would not match the SIP settings in the User profile as described in
Section 5.8. In order to match the incoming calls with a SIP URI, the Local URI can be set either
to Auto which will match any number, or to the specific number used for the service. As this SIP
URI would be used for incoming calls only, the Outgoing Group is set to an unused value, for
example 100. The following screenshot shows an example:

Edit URI
Local URI +413166nnnn5 -
Contact Auto -
Display Mame Auto -
Identity
Identity Mone -
Header P Asserted ID -

Ferwarding And Twinning

Originator

Murmber

Send CallerId None -

Diversion Header Mone -
Registration 0: <MNone> -
Incoming Group 2 -

Outgoing Group 100 -

Max Sessions 10 =

The following screenshot shows the completed configuration:

|SIP LinelTran;por‘t‘ SIP URI|VDIP |SIP CredentialslS[P AdvancedlEngineering|
URI Groups Local URI Contact Display Name Identity Header Originator Number Send CallerID  Diversion Header Credential Max Calls Add...
1 22 <Internal=> <Internal>  <Internal=> <Internal> PAI Diversion MNene 0: <MNen.. 10
2 2100 +413166nnnn5  Auto Auto Mone PAL None None 0: <Non... 10 Ry
3 2 100  +413166nnnnG  Auto Auto MNone PAT Neone MNene 0: <MNen.. 10 Edit
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Select the VoI P tab to set the VVoice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below:

In Section 5.4, system default codecs were defined. If any other codec combination is
required for this SIP Line, select Custom in the Codec Selection drop down menu.
Highlight codecs in the Unused box that are to be used on this line and click on the right
arrows to move them to the Selected box.

Highlight codecs in the Selected box that are not to be used and click on the left arrows
to move them to the Unused box.

Highlight codecs in the Selected box and use the up and down arrows to change the
priority order of the offered codecs if required, for testing with Swisscom, G.711 ALAW
64K, G.711 ULAW 64K and G.729(a) 8K CS-ACELP were used. This reflected the
codec list received from the network.

Select RFC2833/RFC4733 in the DTMF Support drop down menu. This directs Avaya
IP Office to send DTMF tones using RTP events messages as defined in RFC2833.
Check the Re-invite Supported box to allow for codec re-negotiation in cases where the
target of the incoming call or transfer does not support the codec originally negotiated.
Leave the Allow Direct Media Path box unchecked. Direct Media can be used where the
endpoints are in the same network as the internal interface of the Avaya SBCE, though
this was not used during testing.

Check the PRACK/100rel Supported box if early media is required. This was checked
during compliance testing.

Select Media Security as required. In the test environment it was Disabled as there was
an issue with conversion between RTP and SRTP on the Avaya SBCE as described in
Section 2.2.

|SIF‘ LinelTransportlSIP URI| ValP |SIP CredentialslSIF‘ Ad\rancedlEngineering|

Local Hold Music

| Re-invite Supported

Codec Selection |Cust0m N Codec Lockdown
Unused Selected Allow Direct Media Path
G.722 64K G711 ALAW 64K
o 6711 ULAW 64K Force direct media with phones
(5.729(a) BK C5-ACELP | PRACK/100rel Supported
g
=3 31
Fax Transport Support |N0ne v|
DTMF Support | RFC2833/RFC4733 - |
Media Security | Disabled v
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Select the SIP Advanced tab and set the following:

e Select To Header from the Call Routing Method drop down menu. In the test
environment, Swisscom were sending the group number in the Request URI and the DDI
number in the To Header.

e Check the Use + for International as E.164 numbering is used on the SIP Trunk.

e Check the Use PAI for Privacy box to send the calling party number for outbound calls
with CLI Restricted in the P-Asserted-ldentity header.

e Select Emergency Calls from the Send Location Info drop down menu if required.

|SIP LinelTransportlSIP URIlVoIP |SIP Credentials| SIP Advanced |Engineering|

Addressing

Association Method

I By Source IP address

Call Routing Method ITo Header v‘ |

Suppress DMN5 SRV Loockups [

Add UUL header to redirected
calls

Identity

Use "phone-context” [
Add user=phone ]
Use + for International
Use PAI for Privacy
Use Domain for PAL ]
Swap From and PAL/Diversion [
Caller ID from From header ]
Send From In Clear ]
Cache Auth Credentials
User-Agent and Server Headers

Send Location Info IEmergency Calls v‘ |
Add UUT header [}

Media

Allow Empty INVITE [

Send Empty re-INVITE ]

Allow To Tag Change [

P-Early-Media Support INone VI
Send SilenceSupp=0ff [

Media Connection

Preservation I Disabled e ‘

Indicate HOLD ]

Call Control

Call Initiation Timeout (s) 4 =

Call Queuing Timeout (m) 5 :

Service Busy Response 1486- Busy Here V‘
on No User Responding Send I408-RequestTimeout V‘
Suppress Q.850 Reason ]

Header

Emulate NOTIFY for REFER [
Mo REFER if using Diversion [

Note: The configuration shown above shows Location Info sent for Emergency calls. This was
not tested, but is shown for information. The settings for Location data are shown in Section

5.11.

It is advisable at this stage to save the configuration as described in Section 5.12 to make the

Line Group ID defined in Section 5.6 available.
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5.7. Short Codes

Define a short code to route outbound traffic to the SIP line. To create a short code, right-click
Short Code in the Navigation Pane and select New. On the Short Code tab in the Details Pane,
configure the parameters as shown in the example below for public numbers.

e Inthe Code field, enter the dial string which will trigger this short code, followed by a

semi-colon.

e The example shows 9N which will be invoked when the user dials 9 followed by a public

number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to 9N so that the call is passed to the ARS function with the
dialled number unchanged.

e Setthe Line Group Id to the ARS route number described in Section 5.10.
e On completion, click the OK button (not shown).

Configuration

|z

9N;: Dial*

# || Short Code

Code

Feature

Line Group ID

Locale

Telephone Number

Force Account Code

9l

Dial

9N

50: Main

I

O

Force Authorization Code []

A further two examples are shown for an emergency number and withholding CLI:

Code Feature Telephone Line Description
Number Group ID
086756; Dial 086756 100 Emergency Services Test Number. Feature uses
Emergency Location data. Line Group ID is not used.
*679N; Dial INW 50:Main Public Number with *67 prefix. “W” suffix in
Telephone Number withholds CLI.
Short Code | Short Code |
Code 086756; Code "BT9N;
Feature Dial Emergency Feature Dial hd
Telephone Number 086756 Telephone Number ONW
Line Group ID 100 Line Group ID 50: Main -
Locale IIreIand (UK English] Locale l A
Force Account Code [l Force Account Code B
Force Authorization Code  [[] Force Authorization Code  [[]
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5.8. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP
line defined in Section 5.6. To configure these settings, first navigate to User in the Navigation
Pane. The following example shows the User tab for an H.323 Endpoint:
e Change the Name of the User if required.
e Set the Password and Confirm Password.
e Select the required profile from the Profile drop down menu. Basic User is commonly
used; Power User can be selected for SIP softphone, WebRTC and Remote Worker

endpoints.

Configuration | = Extn89105: 89105 ok -
BOOTP (@) User |Voicemai| | DND | ShortCodes | Source Numbers | Telephony | Forwarding | Dial In |‘u’oice Recording | Button Programming
Operator (3)

= Solution MName Extn89105
-§ User(34)
D"'ﬂ Group(1) Password LITTTYTYT
[-@% Short Code (45)

- Directory(0) Confirm Password sessssees
£ Time Profile(0) . )

-8 Account Code(0) Unique Identity

(-fq User Rights(@)
(-5 Location(l)

2 ipol00sery
57 System (1)

{ Line (2) Account Status Enabled -

Audic Conference PIN

Confirm Audic Conference PIN

t-<= Control Unit (11)
@9 Extension (d) Full Name
2§ User(3)
: Molser Extension 89105
g 89105 Extn89105
a 20106 Extn29106 Email Address
g 89108 Extna9108
------ §~ 89109 Extn89109
""" % Group (0) Priority ’5 ']
[-8% Short Code (53)
----- @ Service (0) System Phone Rights [None v]
(-4 Incoming Call Route (7)
----- @z Directory (0) . -
7 Time Pzﬁle ) Profile [Basm User v]
G-l IP Route (2) [C] Receptionist
----- 8 Account Code (0)
..... R Licence (23) Enable Softphone
[#-fiy User Rights (9)
- ARS (1)
(-8 Location (1) Enable one-X TeleCommuter
----- 'm Authorization Code (0)
[H-%2p GSSCP_IPO2

Locale [ v]

Enable one-X Portal Services

[ Enable Remote Worker
[] Enable Communicator

Enable Mobile VoIP Client
Send Mobility Email

Web Collaboration

[T Exclude From Directory

Device Type & Avaya 9611

Note: SIP endpoints require setting of the SIP Registrar Enable in the LANL1 settings. Navigate

to System => <IP Office Name> (not shown) in the Navigation Pane where <IP Office Name>

is the name of the IP Office. Navigate to the LAN1 = VolIP tab in the Details Pane (not shown)
and check the SIP Registrar Enable check box.
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Next select the SIP tab in the Details Pane. To reach the SIP tab click the right arrow on the
right hand side of the Details Pane until it becomes visible.

The values entered for the SIP Name and Contact fields are used as the user part of the SIP URI
in the From header for outgoing SIP trunk calls. These fields should be set to the DDI numbers
assigned to the enterprise from Swisscom in international format. In the example below, one of
the DDI numbers in the test range is used, though some of the digits have been obscured. On
completion, click the OK button (not shown).

SIP Mame

Contact

Button Programming | Menu Programming | Maobility | Group Membership | Announcements | SIP

+413166nnnnl

SIP Display Mame (Alias) Extn83105

+413166nnnnl

Ancnymous

Note: The Anonymous box can be used to restrict Calling Line Identity (CLIR).

5.9. Incoming Call Routing

An incoming call route maps an inbound DDI number on a specific line to an internal extension.
To create an incoming call route, right-click Incoming Call Route in the Navigation Pane and

select New, (not shown).
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On the Standard tab of the Details Pane, enter the parameters as shown below:
e Set the Bearer Capability to Any Voice.
e Setthe Line Group Id to the incoming line group of the SIP line defined in Section 5.6.
e Set the Incoming Number to the incoming number that this route should match on.
Matching is right to left.
e Default values can be used for all other fields.

Configuration ‘ 7 2 +413166nnnn1*
£71 Time Profile(0) ~ || Standard |V0ice Recording | D‘estirlatior'ls|
----- Wl Account Code(0)
#-§i5 User Rights(@)
ol g !_ocation(l) Bearer Capability IAny WVoice M
=43 ipol00serv
-9 System (1) Line Group ID 2 v
BT Line (2}
- Control Unit (11) Incoming Number +413166nnnnl
[+ Extension (4]
D...i User (5) Incoming Sub Address
ﬂ Group [(1)] .
8% Short Code (53) ||| Incoming CLI
@ Se“"ce_ @ 1 Locale l ']
Ele Incoming Call Route (7)
- 2 +413166nnnn0 Priority [1- Low 7]
4P 2 +413166nnnnl
P 2 +413166nnnn2 Tag
P 2 +413166nnnn3
B 2 +413166nnnnd Hold Music Source ’System Source V]
- 2 +413166nnnn5 _ .
@ 2 +413166nnnn6 Ring Tone Override Mene M
a4 Directory (0]

Note: A number of digits of the DDI have been obscured. Number format for incoming calls is
E.164 with leading “+”.

On the Destinations tab, select the destination extension from the pull-down menu of the
Destination field. On completion, click the OK button (not shown). In this example, incoming
calls to the test DDI number on line 2 are routed to extension 89105.

| Standard | Voice Recording | Destinations

TimeProfile Destination Fallback Extension

b | Default Value (89105 Extn89105 I~ [~

Note: Calls coming in to destinations not associated with an extension such as VVoice Mail and
FNE also appear on line 2 in this configuration. The destinations are defined as the short codes
for Voicemail Collect and the FNE Service.
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5.10. ARS

The Main ARS route exists by default and requires editing. Select the ARS Main route and click

on Add.

Configuration | =

g -E X v <>

i+ Operator (3)
=457 Solution
& User(34)
2 Group(1)
~@% Short Code (45)
-8 Directory(0)
71 Time Profile(0)
-l Account Code(0)
-§4 User Rights(@)
-i@ Location(l)
=-%37 ipol00sery
-537 System (1)
17 Line(2)
~“2 Control Unit (11}
Ay Extension (4]
& User(5)
u Group (0)
8% Short Code (53)
- 4B Service (0)
@ Incoming Call Route (7)
@ Directory (0)
£ Time Profile (0)
-lill IP Route (2)
8 Account Code (0)
Wy Licence (23)
-4 User Rights (@)
- ARS (1)
g 50: Main
-8 Location (1)
ﬁ Authorization Code (D)
-7 GS5CP_IPO2

=- R BOOTP (%) ARS

ARS Route Id

Route Mame

Dial Delay Time

Description

In Service

Time Profile

50

Main

System Default (1)

) Secondary Dial tone

SystemTene

Check User Call Barring

Out of Service Route

1

<None>

|

Out of Hours Route

[(NDHE)- vl

[(NDHE) v]

Code
7
11
an;
90035301 ICCCE0
ORCCCK
086756

Telephone Number
112

N

0035391N

0041N
086756

Feature

Dial

Line Group ID

2
Dial Emergency 2
Dial 2
Dial 2
Dial 2

2

Dial Emergency

Remove

Edit...

30

.| e} Alternate Route

<MNone» v]

Define numbers as required. An example for national numbers is as follows:

e Define the Short Code, the example shows both a 10 digit national number and an
international number with country code and city code prefixed with 9 for an outside line.
Select Dial in the Feature drop down menu.

e Define the Telephone Number without the 9 which removes it and sends the number as
dialled. All X characters can be replaced with a single N.

e Select the Line Group ID defined in the SIP Line URI described in Section 5.6. During
testing this was 2 for the SIP Trunk. Click on OK

Edit Short Code

Edit Short Code

Code GOROOOOOOK;
Feature Dial

Telephone Mumber 041N

Line Group 1D 2

Locale [

Force Account Code ]
Force Authorization Code [

Code 5003535100000

Feature Dial -
Telephone Mumber 0035391N

Line Group 1D 2 -

Locale [

Force Account Code ]
Force Authorization Code [
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The X used in the Code indicates any digit and *“;” causes the system to wait for the full number
to be dialled or a “#”. The next example shows an emergency number. Set Feature to Dial

Emergency. The number shown is not a valid Emergency Services number, it is a test number
used to check Location data.

Edit Short Code
Code 086756:
Feature Dial Emergency -
Telephone Mumber 086756
Line Group D 2 -
Locale [ -
Force Account Code [l
Force Authorization Code [

5.11. Location

If Location information is required for calls to Emergency Services, right-click Location in the
Navigation Pane and select New (not shown). On the Location tab of the Details Pane, enter the
parameters as required. An example used during testing is shown below:
e Define a Location Name.
e Define a Subnet Address and Subnet Mask as required. In the test environment, there
was no differentiation based on subnet.

e Select the Emergency ARS from the drop down menu. In the test environment default
ARS of 50: Main was used.

e In the example, all other fields were left at default values.

Configuration | =

Galway ek - X v
’s BOOTP () Location | Address
#-¢% Operator (3)
-3¢ Solution Location Name Galway
§ User34) o ) oo
a Group(l) This Location is common te all systems,
X Short Code (45) Location ID 3
< Directory(0)
£ Time Profile(0) Subnet Address 0 0 0 0
-l Account Code(0)
-§3 User Rights(9) Subnet Mask 0 0 0 0
S f ;D:fgloizg) Emergency ARS [4 Nene> v]
B System (1) Fallback System [<no overide> -
B Line (2)
(-2 Control Unit (11) <Mone»
-4 Extension (4]
& User (3) Call Admission Control
ﬂ Group (0)
(- @% Short Code (53) Total Maximum Calls ~ Unlimited -
@ Service (0]
(-3 Incoming Call Route (7) External Maximum Calls | Unlimited =
448 Directory (0] . =
£ Time Profile (0) Internal Maximurmn Calls | Unlimited 2
Hl IP Route (2)
8 Account Code (0) Time Settings
% Licence (23) Time Zone Same as System
[#-§5 User Rights (9)
E- ARS (1) 00:00
et 50: Main
Bn'—q Location (1)
-8 3: Galway <Add New Entry> Edit Delete
m Authorization Code (0)
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Click on the Address tab and enter data as required. The following screenshot shows an example
used during testing:

| Location| Address |

RD

PRD

POD

5TS

PRM

POM

RDSEC

RDBR

Country Code

Connacht
Galway
Galway
Mervue

Business Park

Units 25-29

RDSUBBR

1, Please refer to the help for Information regarding this screen. Failure to format the address properly
could result in improper address association,

HMO

HMNS

LMK

BLD

Loc

PLC

FLR

UNIT GS5CP Lab
ROOM

SEAT

NAM 123456
ADDCODE

PCN

PC

POBOX

Note: The above example bears no relation to the information that would be used in the live
environment. It was specified for the sole purpose of being identifiable in the SIP messages of
the test calls.

The location data defined in the test environment is applied to the whole IP office. This can be
refined according to subnet and also individual extensions. The SIP Line is configured to send
location data as described in Section 5.6.2.
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5.12. Save Configuration

Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.

File

Edit View Tools Help

Open Cenfiguration...  Ctrl+0

Close Configuration

|Q Save Configuration Ctrl+5 ummary

Save Configuration As.., Server Edition Primary

Change Working Directory...

Preferences... - Hardware Installed

) Control Unit: IPO-Linux-PC

Offline Secondary Server, NONE

Advanced Expansion Systems: 10.10.4.100

Backup/Restore System ldentification: b Do zadB 40 3 2Ny Do s e cbd dvdds 3o 2

Emport/Export Serial Nu.mber: N2ohEHA sl

= System Settings

Exit IP Address: 10.10.4.101
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6. Configure Avaya Session Border Controller for Enterprise

This section describes the configuration of the Avaya Session Border Controller for Enterprise
(Avaya SBCE). The Avaya SBCE provides security and manipulation of signalling to provide an
interface to the Service Provider’s SIP Trunk that is standard where possible and adapted to the
Service Provider’s SIP implementation where necessary.

6.1. Access Avaya Session Border Controller for Enterprise

Access the Session Border Controller using a web browser by entering the URL https://<ip-
address>, where <ip-address> is the private IP address configured at installation. A log in
screen is presented. Log in using the appropriate username and password.

ﬂ v ﬁ ﬁ LogIn
Username ucsec

Password:
| Login |
Session Border Controller WELCOMETO Avaa 285G
for Ente rp rise Unauthorized access to this machine is prohibited. This system is for

the use authorized users only. Usage of this system may be monitored
and recerded by system personnel

Anyone using this system expressly consents to such monitering and
is advised that if such menitoring revesls possible evidence of criminal
activity, system personnel may provide the evidence from such
monitoring to law enfercement cfficials

@ 2011 - 2017 Awvaya Inc. All rights reserved

Once logged in, a dashboard is presented with a menu on the left-hand side. The menu is used as
a starting point for all configuration of the Avaya SBCE.

Alarms  Incidents Status v Logsv  Diagnostics  Users Settings v Help v Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Dashboard
Backup/Restare
System Time 01:48:39 PM GMT Refresh EMS
System Management
> Global Parameters R 7.200-18-13712 Portwell46
- (lobal Profiles Build Date Thu Jun 1 00:12:50 UTC 2017
> PPM Services License State @ OK

» Domain Palicies Aggregate Licensing Overages 0
> TLS Management .

. R X Peak Licensing Overage Count 0
> Device Specific Settings

Last Logged in at 1102172017 13:46:06 GMT
Failed Login Attempts 0
MNone found. None found
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6.2. Define Network Management

Network information is required on the Avaya SBCE to allocate IP addresses and masks to the
interfaces. Note that only the Al and B1 interfaces are used, typically the Al interface is used for
the internal side and B1 is used for external.

To define the network information, navigate to Device Specific Settings = Network
Management in the main menu on the left hand side and click on Add.

Dashboard Network Management: Portwell46
Administration
Backup/Restore

Interfaces | | Networks
System Management
> Global Parameters Portwell4§ Add
> Global Profiles

Name Gateway ng}netMas”I: L Interface IP Address

» PPM Services refix Leng'
» Domain Policies Internal 10.10.4.1 255.255.255.0 Al 10.10.4.102 Edit Delete

> TLS Management
4 Device Specific Settings

Network
Management

Enter details for the external interface in the dialogue box:

e Enter a descriptive name in the Name field.

e Enter the default gateway IP address for the external interfaces in the Default Gateway
field. In the test environment, this was the IP address of the VPN server.

e Enter the subnet mask in the Subnet Mask field.

e Select the external physical interface to be used from the Interface drop down menu. In
the test environment, this was B1.

e Click on Add and an additional row will appear allowing an IP address to be entered.

e Enter the external interface IP address for connection to the SIP trunk in the IP Address
field and leave the Public IP and Gateway Override fields blank.

e Click on Finish to complete the interface definition.

Add Network X

Mame External
Default Gateway 192 168 201
Metwork Prefix or Subnet Mask 255 255 2550
Interface Bl v
| Add |

IP Address Public IP Gateway Override
192.168.20.20 Use IP Address Use Default Delete

| Finish |

BG; Reviewed: Solution & Interoperability Test Lab Application Notes 32 of 64

SPOC 2/6/2018 ©2018 Avaya Inc. All Rights Reserved. SSBC_IPO101_SBC




Click on Add again to define the internal interface if required. Enter details in the dialogue box

(not shown):

e Enter a descriptive name in the Name field.
e Enter the default gateway IP address for the internal interfaces in the Default Gateway

field.

e Enter the subnet mask in the Subnet Mask field.

e Select the internal physical interface to be used from the Interface drop down menu. In
the test environment, this was Al.

e Click on Add and an additional row will appear allowing an IP address to be entered.

e Enter an internal interface IP address for connection to IP Office in the IP Address field
and leave the Public IP and Gateway Override fields blank.

e Click on Finish to complete the interface definition.

The following screenshot shows the completed Network Management configuration:

Portwell46

Network Management: Portwell46

Interfaces || Networks

Add
Subnet Mask /
Name Gateway Prefix Length Interface IP Address
Internal 10.10.4.1 2552852550 Al 10.10.4.102 Edit Delete
External 192.168.20.1 2552552550 B1 192.168.20.20 Edit Delete

Select the Interface Configuration tab and click on the Status of the physical interface to
toggle the state. Change the state to Enabled where required.

Network Management: Portwell46

m Interfaces ‘ ‘ Networks ‘
Portwell46
Add WVLAN
Interface Name VLAN Tag Status
Al Enabled
A2 asbcedb.avaya.com says: *
B Are you sure you wish to change the status of Interface to Enabled?
oK Cancel
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Note: to ensure that the Avaya SBCE uses the interfaces defined, the Application must be
restarted.

e Click on System Management in the main menu (not shown).

e Select Restart Application indicated by an icon in the status bar (not shown).

6.3. Define TLS Profiles

TLS profiles are required to support TLS on the interfaces. The implementation of certificates is
beyond the scope of this document and is assumed to be already in place. The signalling
interfaces require a TLS server profile and the server configuration requires a TLS client profile.

6.3.1. Server Profile

To define a TLS server profile on the Avaya SBCE, navigate to TLS Management > Server
Profiles in the main menu on the left hand side. Click on Add.

Dashboard Server Profiles

Administration Add

Backup/Restore

Server Profiles
Systemn Management Use the add button to create a new Server profile.
> Global Parameters No entries found

> Global Profiles

> PPM Services

> Domain Policies

4 TLS Management
Certificates
Client Profiles

Server Profiles

Details of the TLS server profile for the signalling interfaces are entered here.

e In the Name field enter a descriptive name for the server profile.

e Inthe Certificate drop down menu, select the Avaya SBCE identity certificate to be used
for this profile.

e Select Peer Verification as required. In the test environment peer verification was made
optional by selecting Optional in the drop down menu.

e Highlight the trusted root certificate in the Peer Certificate Authorities field.

e Set the Verification Depth as required. The example shown is for the link with IP Office
which has an identity certificate provided by a System Manager implemented as a sub-
CA. This means that the IP Office identity certificate is signed by an intermediate
certificate which is in turn signed by a root certificate. This gives it a depth of 2.
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Once the se

rver profile details are entered, click on Next.

New Profile X

WARNING: Due to the way OpenSSL handles cipher checking, Cipher Suite validation will
pass even if one or more of the ciphers are invalid as long as at least one cipher is valid. Make

sure to carefully check your entry as invalid or incomrectly entered Cipher Suite custom values
may cause catastrophic problems.

TLS Profile
Profile Name CPE_Server
Certificate ashcedB.pem d
Peer Verfication Optional v
GSSCP_Root.crt a

Peer Certificate Autharities

Peer Certificate Revocation Lists

Verification Depth 2

MNext

The next dialogue box completes the server profile configuration. In the test environment, these
parameters were left at default values. Click on Finish.

New Profile X

Renegotiation Parameters

Rensgotiation Time 0 seconds

Renegotiation Byte Count 0

Handshake Options

Wersion ¢ TLS12 TLS 1.1 TLS 1.0
Ciphers ® Default FIPS Custom
vale HIGH:IDH:IADH:IMD5:laNULL:leNULL:@STRENGT}
| Back | | Finish |
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6.3.2. Client Profile

To define a TLS client profile on the Avaya SBCE, navigate to TLS Management = Client
Profiles in the main menu on the left hand side. Click on Add.

Dashboard Client Profiles
Administration -
Backup/Restore

Client Profiles o
System Management Use the add button to create a new Client profile.
> Global Parameters No entries found

> Global Profiles

> PPM Services

> Domain Policies

4 TLS Management
Certificates

Client Profiles

Details of the TLS client profile for the signalling interfaces are entered here.
e Inthe Name field enter a descriptive name for the client profile.
e In the Certificate drop down menu, select the Avaya SBCE identity certificate to be used
for this profile.
e Highlight the trusted root certificate in the Peer Certificate Authorities field.
e Set the Verification Depth as required. This was 2 in the test environment as explained
in the Server Profile configuration.

New Profile X

WARNING: Due to the way OpenSSL handles cipher checking, Cipher Suite validation will
pass even If one or more of the ciphers are invalid as long as at least one cipher is valid. Make
sure to carefully check your entry as invalid or incomectly entered Cipher Suite custom values

may cause catastrophic problems.

TLS Profile
Profile Name CPE_Client
Certificate asbcedf.pem r
Peer Verification Required
GSSCP_Root.crt -

Peer Certificate Authorities

Peer Certificate Revocation Lists

Verification Depth 2
Extended Hostname Venfication

Custemn Hostname Cverride
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Note: Peer Verification is always Required for the client profile.

Click on Next to complete the client profile configuration. In the test environment, these
parameters were left at default values. Click on Finish.

New Profile X
Renegotiation Parameters

Renegotiation Time ] seconds

Renegotiation Byte Count D

Handshake Options

Version 4 TLS12 TLS 1.1 TLS 1.0
Ciphers ® Default FIPS Custom
Value HIGH:IDH:!ADH:IMD5:laNULL:leNULL:@STRENGT}

[What's this?)

Back Finish

6.4. Define Interfaces

When the IP addresses and masks are assigned to the interfaces, these are then configured as
signalling and media interfaces. Testing was carried out using TCP for transport of signalling
between IP Office and the Avaya SBCE, and UDP for transport of signalling between the Avaya
SBCE and Swisscom Smart Business Connect. Signalling and media interfaces were required on
both the internal and external sides of the Avaya SBCE to handle traffic between the Avaya
SBCE and IP Office, and Avaya SBCE and Swisscom Smart Business Connect.

6.4.1. Signalling Interfaces

To define the signalling interfaces on the Avaya SBCE, navigate to Device Specific Settings =
Signaling Interface in the main menu on the left hand side. Click on Add.

Dashboard Signaling Interface: Portwell46
Administration
Backup/Restore
System Management Signaling Interface
> Global P " Portwelld6 - » S ” » " " __
obal Faramelers Modifying or deleting an existing signaling interface will require an application restart before taking effect. Application restarts can be

> Global Profiles issued from System Management.

> PPM Services Add

> Domain Policies
» TLS Management Use the add button to create a new Signaling Interface.

4 Device Specific Settings

Network Management
edia Interface

Signaling Interface

Details of transport protocol and ports for the external and internal SIP signalling are entered in
the dialogue box. Note that in the test environment, the internal interface was enabled for both
TCP and TLS.
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Enter details for the signalling interface as follows:

Mame

IP Address

TCP Port

Leave blank to disable

UDP Port

Leave blank to disable

TLS Port

Leave blank to disable

TLS Profile

External

External (B1, VLANCO) v
192.168.2020 -

5050

MNone v

Enable Shared Control

Shared Control Port

Finish

In the Name field enter a descriptive name for the external signalling interface.

In the IP Address drop down menus, select the external network interface and IP
address. Note that when the external network interface is selected, the bottom drop down
menu is populated with the available IP addresses as defined in Section 6.2. In the test
environment, this was IP address 192.168.20.20.
Enter the UDP port number in the UDP Port field, 5060 is used for Swisscom.

Add Signaling Interface X

The internal signalling interfaces are defined in the same way. In the IP Address drop down
menus, select the internal network interface and IP address. Additionally, if TLS is used between
the Avaya SBCE and the IP Office, enter the port number and select the TLS Profile created in
Section 6.3.1 in the drop down menu. Click on Finish.
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Mame

IP Address

TCP Port

Leave blank to disable

UDP Port

Leave blank to disable

TLS Port

Leave blank to disable

TLS Profile

Internal

Internal (A1 VLAND) v
10104102 v

5060

5060

CPE_Server v

Enable Shared Control

Shared Control Port

Finish

Add Signaling Interface X
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6.4.2. Media Interfaces

To define the media interfaces on the Avaya SBCE, navigate to Device Specific Settings 2
Media Interface in the main menu on the left hand side. Click on Add.

Dashboard

Administration

Backup/Restore

System Management

> Global Parameters

> Global Profiles

> PPM Services

> Domain Policies

> TLS Management

4 Device Specific Settings
MNetwork Management
Media Interface

Media Interface: Portwell46

Portwell46

issued from System Management.

Modifying or deleting an existing media interface will require an application restart befare taking effect. Application restarts can be

Use the add button to create a new Media Interface

Add

Details of the RTP port ranges for the internal and external media streams are entered in the
dialogue box. The IP addresses for media can be the same as those used for signalling.

e Inthe Name field enter a descriptive name for the media interface.

e Inthe IP Address drop down menus, select the network interface and IP address. Note
that when the network interface is selected, the bottom drop down menu is populated
with the available IP addresses as defined in Section 6.2. In the test environment, this
was 192.168.20.20 for the external and 10.10.4.102 for the internal interfaces.

e Define the RTP Port Range for the media path with Swisscom Smart Business Connect
(external) or IP Office (internal), during testing this was left at default values of 35000 to

40000.

e Click on Finish.

Name

IP Address

Port Range

TLS Profile

Add Media Interface

Extemnal Name

External (B1. WVLAN Q) v
192.168.2020 -

IP Address

35000 - 40000

Port Range

TLS Profile

Finish

Add Media Interface

Internal

Internal (A1, VLANDO) v
10.10.4.102  ~

35000 - 40000

CPE_Server ¥

Finish

Note: If TLS and SRTP are used between the Avaya SBCE and the IP Office, the TLS Profile
created in Section 6.3.1 can be selected in the drop down menu. TLS and SRTP were not used in
the test environment because of the issue described in Section 2.2.
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The screenshot shows the completed configuration:

Media Interface: Portwell46

Devices

Portwell46

Media Interface

Modifying or deleting an existing media interface will require an application restart before taking effect. Application

restarts can be issued from System Management.

Add
ELEN S
Name e, Port Range TLS Profile
10.10.4.102 i
Internal Intemal (1. YLAN 0) 35000 - 40000 CPE_Server Edit Delete
External 192.168.20.20 35000 - 40000  None Edit Delete

External (B1, VLAN 0}

6.5. Define Server Interworking

Server interworking is defined for servers connected to the Avaya SBCE. To define server
interworking, navigate to Global Profiles = Server Interworking in the main menu on the left
hand side. Server Interworking for Swisscom Smart Business Connect can be defined by cloning
a default profile. Highlight the avaya-ru profile and click on Clone.

Dashboard Interworking Profiles: avaya-ru
Administration Add Clone
Backup/Restore
Interworking Profiles [tis not recommended to edit the defaults. Try cloning or adding a new profile instead.
System Management
©s2100
» Global Parameters General || Timers H Privacy H URI ipulati H Header Manipulati ‘ ‘ Advanced |
4 Global Profiles avaya-ru
Domain Dos
Server Interworking Hold Support NONE
Media Forking 180 Handling None
Routing 181 Handling None
Server Configuration :
) 182 Handling None
Topology Hiding
Signaling Manipulation 183 Handling Nene
URI Groups Refer Handling No
SNMP Traps URI Group Nene
Time of Day Rules Send Hold No
FGDN Groups
Delayed Offer Yes
Reverse Proxy Policy
RADIUS 3xx Handling Mo
> PPM Services Diversion Header Support No
> Domain Policies Delayed SDP Handling No
> TLS Management Re-Invite Handling No
> Device Specific Settings X
Prack Handling No
Allow 18X SDP No
T.38 Support MNo
URI Scheme sIp
Via Header Format RFC3261
Edit
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A dialogue box is displayed. In the Name field enter a descriptive name for the SIP Trunk, in the
test environment Network was used. Click on Finish.

Clone Profile

Profile Name avaya-ri
Clone Name MNetwork
| Fimish |

The profile is created and can be edited from the main menu. Configuration of interworking
includes Hold support, T.38 fax support and SIP extensions. Select the General tab and click on
Edit (not shown). In the test environment, the T.38 Support box was checked even though T.38
fax is not supported. All the rest of the settings were left at default values. Click on Finish.

Editing Profile: Network X

General

* None
Held Support RFC2543-¢c=0.0.00
RFC3264 - a=sendonly

180 Handling ® None SDP No SDP
181 Handling ® None SDP No SDP
182 Handling * None SDP No SDP
183 Handling ® None SDP No SDP

Refer Handling
URI Group MNone v
Send Hold
Delayed Offer
3xx Handling
Diversion Header Support
Delayed SDP Handling
Re-Invite Handling

Prack Handling

Allow 18X SDP
T.38 Support v
URI Scheme " gp TEL ANY
Via Header Format - ARG
RFC2543
| Finish |
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Select the Advanced tab (not shown) and click on Edit. Define the following settings in the
dialogue box:

e Check the None radio button in the Record Routes field.

e Select None in the Extensions drop down menu.

e Ensure that the Has Remote SBC box is checked.

e Click on Finish.

Editing Profile: Network X

®' None
Single Side
Record Routes Both Sides

Dialog-lnitiate Only (Single Side)
Dialog-Initiate Only (Both Sides)

Include End Point IP for Context Lookup |«

Extensions MNone ¥

Diversion Manipulation
Diversion Condition None v
Diversion Header URI

Has Remote SBEC v

Route Response on Via Port

Relay INVITE Replace for SIPREC

MOBX Re-INVITE Handling

DTMF

* None
SIP Motify
DTMF Support RFC 2833 Relay & SIP Notify
SIP Info
RFC 2833 Relay & SIP Info
Inband

Finish

Repeat the process to define Server Interworking for IP Office. Navigate to Global Profiles 2>
Server Interworking in the main menu on the left hand side. Highlight the avaya-ru profile and
click on Clone.
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In the Name field of the dialogue box, enter a descriptive name for IP Office. In the test
environment CPE was used. Click on Finish.

Clone Profile

Profile Name avaya-ru

Clone Name CPE

| Finish |

The profile is created and can be edited from the main menu. Select the General tab (not shown)
and click on Edit. In the dialogue box (not shown) the settings can be left at default values,
though the T.38 Support box was checked in the test environment. Select the Advanced tab (not
shown) and click on Edit. Define the following settings in the dialogue box:

Check the Both Sides radio button in the Record Routes field.

e Select Avaya in the Extensions drop down menu.
e Ensure that the Has Remote SBC box is checked.
e Click on Finish.
None
Single Side
Record Routes * Both Sides
Dialog-Initiate Only (Single Side)
Dialog-Initiate Only (Both Sides)
Include End Point IP for Context Lookup [
Extensions Avaya ¥
Diversion Manipulation
Diversion Condition None v
Diversion Header URI
Has Remote SBC v
Route Response on Via Port
Relay INVITE Replace for SIPREC
MOBX Re-INVITE Handling
* None
SIP Notify
DTMF Support RFC 2833 Relay & SIP Notify
SIP Info
RFC 2833 Relay & SIP Info
Inband
| Finish |
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6.6. Define Servers

A server definition is required for each SIP Trunk connected to the Avaya SBCE. In the case of
the test environment, this was IP Office on the enterprise side and the Swisscom SIP Trunk on
the network side. To define the Swisscom Smart Business Connect server, navigate to Global
Profiles = Server Configuration in the main menu on the left hand side. Click on Add.

Dashboard Server Configuration

Administration
Add

Backup/Restore

Server Profiles -
System Management . Use the add button to create a new Server Configuration profile.
> Global Parameters No entries found

4 Global Profiles
Domain DoS
Server Interworking
Media Forking
Routing

Server Configuration

Enter an appropriate name in the dialogue box displayed. Note that for the purposes of
documentation, an assumption was made that that the Avaya SBCE was connecting to an SBC in
the Swisscom Smart Business Connect network.

Add Server Configuration Profile

Profile Name Network_SBC

Next

Click on Next and enter configuration settings in the dialogue box displayed:

e Inthe Server Type drop down menu, select Trunk Server.
e Click on Add to enter an IP address or FQDN.
e Inthe IP Address / FQDN box, type the IP address of the Swisscom network SBC.
e Inthe Port box, enter the port to be used for the SIP Trunk, typically 5060 for UDP.
e Inthe Transport drop down menu, select UDP.
Server Type Trunk Server v
SIP Domain
TLS Client Profile None v
Add
IP Address / FQDN Port Transport
192.168.2.19 5060 UDP v | Delete
Back Mext
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Click on Next and enter the SIP USER and SIP-Password provided by Swisscom into the
dialogue box. The SIP USER is used for the User Name and the Realm is left blank.

Add Server Configuration Profile - Authentication X

Enable Authentication o
User Name <Username:s
Realm

[Leave blank to detect from server challengs)

Password  |essssses

Confirm Password ~ |ssessees

Back Mext

Click on Next again and enter registration details in the dialogue box:
e Check the Enable Heartbeat box.
e Select REGISTER from the Method drop down menu.

e Enter the Frequency for registration, during testing 90 was used so that the Avaya SBCE

registered with Swisscom Smart Business Connect every 90 seconds.

e Enter the From URI and To URI as the <User Name>@<IP Address> where the User
Name is the SIP ID provided by Swisscom and the IP Address is the external interface of

the Avaya SBCE and the Swisscom SBC respectively.
e Click on Next

Add Server Configuration Profile - Heartbeat X

Enable Heartbeat 7
Method REGISTER ¥
Frequency 90 seconds
From URI +413166nnnn0@192.168.20
To URI +413166nnnn0@192.168.2 -
Back Mext

Click on Next again to get to the final dialogue box.
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The final dialogue box contains the Advanced settings:
e Inthe Interworking Profile drop down menu, select the profile for Swisscom Smart
Business Connect defined in Section 6.5.
e Leave the other fields at default settings.
e Click on Finish.

Add Server Configuration Profile - Advanced X

Enable DoS Protection

Enable Grooming

Interworking Profile Network ¥
Signaling Manipulation Script None v
Securable
Enable FGDN

TCP Failover Port 5060

TLS Failover Port 5061
Tolerant
URI Group MNone v

Back Finish

Use the previous process to define the Call Server configuration for IP Office if not already
defined. Navigate to Global Profiles = Server Configuration in the main menu on the left
hand side. Click on Add (not shown). Enter an appropriate name in the dialogue box displayed.

Add Server Configuration Profile

Profile Name IP_Office

Mext
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Click on Next and enter configuration settings in the dialogue box displayed:

e Inthe Server Type drop down menu, select Call Server.
e [fusing TLS, select the TLS Client Profile created in Section 6.3.2. in the drop down

menu

e Click on Add to enter an IP address or FQDN.

e Inthe IP Address/ FQDN box, type the IP address of the IP Office.

e Inthe Port box, enter the port to be used for IP Office. In the test environment, this was

5060 for TCP.

e Inthe Transport drop down menu, select the signalling transport to be used. In the test

environment, this

was TCP.

Edit Server Configuration Profile - General X

Server Type Call Server v
SIP Domain
TLS Client Profile Mone T
Add
IP Address / FQDN Port Transport
10.10.4.101 5060 TCP Delete
| Back | | Next |
Click on Next again to get to the final dialogue box.
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The final dialogue box contains the Advanced settings:
e Inthe Interworking Profile drop down menu, select the profile for IP Office defined in
Section 6.5.
e Leave the other fields at default settings.
e Click on Finish.

Add Server Configuration Profile - Advanced X

Enable DoS3 Protection
Enable Grooming
Interworking Profile CPE v
Signaling Manipulation Script None ¥
Securable
Enable FGDN
TCP Failover Port 5060
TLS Failover Port 5061
Tolerant
URI Group None v
| Back | Finish

The following screenshot shows the General tab of the completed Server Configuration for IP
Office:

Server Configuration: IP_Office

Add | Rename || Clone || Delete |

Server Profiles General ‘ ‘ Authentication ‘ ‘ Heartbeat H Ping | | Advanced |
MNetwork_SBC
Server Type Call Server
IP_Office
IP Address / FQDN Port Transport
10.10.4.101 5060 TCP
Edit

6.7. Define Routing

Routing information is required for routing to the Swisscom Smart Business Connect network
SBC on the external side and IP Office on the internal side. The IP addresses and ports defined
here will be used as the destination addresses for signalling.
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To define routing to the Swisscom network SBC, navigate to Global Profiles 2 Routing in the
main menu on the left hand side. Click on Add.

Dashboard Routing Profiles: default
Administration Add
Backup/Restore -
Routing Profiles It is not recommended to edit the defaults. Try cloning or adding 2 new profile instead.
System Management
> Global Parameters HERTE Routing Profile
4 Global Profiles
Update Priority Add
Domain DoS
Server Interworking Priority gﬁ::up E';;‘e of Load Balancing  Next Hop Address Transport
Media Forking Auto-
Routing default  DNS/SRV Auto-Detect Detoct Edit Delete
Server Configuration

Enter an appropriate name in the dialogue box.

Routing Profile

Profile Name Metwork_SBC

MNext

Click on Next and enter details for the Routing Profile for the SIP Trunk:

Leave the Load Balancing drop down menu at default of Priority.

Click on Add to specify the next hop address for the SIP Trunk.

Assign priority in the Priority / Weight field. In the test environment, 1 was used.
Select the Server Configuration defined in Section 6.6 in the Server Configuration drop
down menu, the Next Hop Address field will be automatically populated.

e Click on Finish.

Add Routing Rule X

URI Group * v Time of Day default
Load Balancing Priority v NAPTR
Transport None MNext Hop Priority i
Next Hop In-Dialog Ignore Route Header
ENUM ENUM Suffix
Add
Priority / Weight  Server Configuration MNext Hop Address Transport
1 Metwork_SBC v 192.168.2.19:5060 (UDP) v None v| Delete
Finish
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Repeat the process for the Routing Profile for IP Office: The following screenshot shows the
completed profile:

Routing Profiles: IP_Office
Add | Rename || Clone || Delete |

Routing Profiles Click here to add a description.
default
Routing Profile

Netwark_SBC
Update Priority Add

URI Time of
Group  Day

IP_Office
Load Balancing  MNext Hop Address Transport

Priority

1 * default Priority 10104101 TCP Edit Delete

Note: The Name is IP_Office and the Next Hop Address is 10.10.4.101 in this configuration.

6.8. Topology Hiding

Topology hiding is used to hide local information such as private IP addresses and local domain
names. The local information can be overwritten with a domain name or IP addresses. The
default Replace Action is Auto, this replaces local information with IP addresses, generally the
next hop for terminating addresses or Avaya SBCE interfaces for originating addresses.

To define Topology Hiding for Swisscom Smart Business Connect, navigate to Global Profiles
-> Topology Hiding in the main menu on the left hand side. Highlight the default profile and
click on Clone.

Dashboard Topology Hiding Profiles: default
Administration Add Clone
Backup/Restore .
System Management ;?g_l]‘lsggy Hiding [tis not recommended to edit the defaults. Try cloning or adding a new profile instead.
» Global Parameters default Topology Hiding
4 Global Profiles .
Domain DoS cisco_th_profile Header Criteria Replace Action Overwrile Value
Server Interworking To IP/Domain Auto
IMedia Forking Record-Route IP/Domain Auto —
Routing sop IP/Demain Auto
Server Configuration
Referred-By IP/Domain Auto —
Topology Hiding
. Refer-To IP/Domain Auto
Signaling Manipulation
URI Groups Via IP/Domain Auto =
SNMP Traps From IP/Domain Auto
Time of Day Rules Request-Line IP/Domain Auto —
FGDN Groups
Reverse Proxy Policy [ Edit]
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Enter a suitable name in the Clone Profile dialogue box:

Clone Profile

Profile Name default
Clone Name Network
| Finish |

Edit the clone and enter details in the Topology Hiding Profile pop-up menu if required.
e Click on Add Header and select from the Header drop down menu.
e Select IP or IP/Domain from the Criteria drop down menu depending on requirements.
e Leave the Replace Action at the default value of Auto unless a specific domain name is
required in which case select Overwrite and enter the domain in the Overwrite Value
field. Click on Finish.

Edit Topology Hiding Profile X

Header Cntena Replace Action Overwrite Value

[Via v| [IPjDomain V| [Auto v| Delete
|Request—Line V| |IF’,I'DDmain V| |Autﬂ V| Delete
[sDP ~v| [IP/Domain V| [Auto v Delete
|TD V| |IF’,I'DDmain V| |Autﬂ V| Delete
|Refer—TD V| |IF’,I'DDmain V| |Autﬂ V| Delete
|From V| |IF’.ch>main V| |Autc V| Delete
[Record-Route ~| [IP/Domain  v| [Auto v Delete

To define Topology hiding for IP Office, follow the same process. Navigate to Global Profiles
-> Topology Hiding in the main menu on the left hand side, highlight the default profile and
click on Clone (not shown). Enter a suitable name in the Clone Profile dialogue box:

Clone Profile

Profile Name default

Clone Name CPE

| Finish |

Edit the clone and enter details in the Topology Hiding Profile pop-up menu (not shown) if
required. Note that during testing, the Topology Hiding for both Swisscom Smart Business
Connect and IP Office was left at default values.
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6.9. Domain Policies

Domain policies are used to bring together a number of different rules for use in a server flow
described in Section 6.10. Swisscom Smart Business Connect testing was carried out without
security on the signalling and media between the Avaya SBCE and the IP Office because of an
issue with RTP / SRTP conversion described in Section 2.2. The process of media encryption is
carried out on the media by using a specific Media Rule and is described here for information.

6.9.1. Media Rules

Media rules can be used to manipulate media in a number of ways including encryption.
Although there are default media rules for encryption, a bespoke one is described here that
allows fallback to unencrypted media.

To define the media rule, navigate to Domain Policies =>Signaling Rules in the main menu on
the left hand side. Highlight the default avaya-low-med-enc media rule for encrypted media and
click on Clone.

Dashboard Media Rules: avaya-low-med-enc
Administration Add | [Filter By Device... M Clone
Backup/Restore
Media Rules [tis not recommended to edit the defaults. Try cloning or adding a new rule instead.
System Management

default-low-med
> Global Parameters Encryption ‘ ‘ Codec Prioritization ‘ ‘ Advanced | QoS

> Global Profiles default-low-med-enc
> PPM Services default-high Audio Encryption
4 Domain Palicies . Preferred Formats SRTP_AES_CM_128_HMAC_SHA1_80
default-high-enc
Application Rules Encrypted RTCP
Border Rules avaya-low-med-enc
MK
Media Rules
Security Rules Lifetime Any
Signaling Rules Interworking #
End Point Policy
Groups Video Encryption

Session Policies Preferred Formats RTP

> TLS Management
Interworking <
> Device Specific Settings

Miscellaneous.

Capability Negotiation

Enter a Rule Name in the Clone Rule dialogue box and click on Finish.

Clone Rule
Rule Name avaya-low-med-enc
Clone Name cpe-low-med-enc
Finish

The only change applied in this example is to add unencrypted media as a second choice.
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To add unencrypted media as a second choice, highlight the recently created Media Rule click on
the Encryption tab and click on Edit (not shown).
e Select the required encryption in the Preferred Format #1 drop down menu. The
example shows SRTP_AES _CM_128 HMAC_SHA1_80.
e Select the RTP in the Preferred Format #2 drop down menu.
e Other fields can be left at default values.
e Click on Finish.

Media Encryption

|

Audio Encryption

Preferred Format #1 SRTP_AES_CM_1258_HMAC_SHA1_80 v
Preferrad Format #2 RTP M
Preferred Format #3 NONE v
Encrypted RTCP

MEKI

Lo o o any v 2

Interworking v

Preferred Format #1 RTP v
Preferrad Format #2 NOMNE M
Preferred Format #3 NOMNE v

Encrypted RTCP

MKl

Lifetime an
Lesve blank to maich any value.

Interworking v

Miscellaneous

Capability Negotiation

Finish

6.9.2. End Point Policy Group

An End Point Policy Group is required to implement the media rule. To define one for use in the
IP Office server flow, navigate to Domain Policies = End Point Policy Groups in the main
menu on the left hand side.
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Select an appropriate pre-defined Policy Group for encryption, in the test environment this was
avaya-default-low-enc, and click on Clone.

Dashboard Policy Groups: avaya-def-low-enc

Administration

Backup/Restore

System Management

> Global Parameters

> Global Profiles

> PPM Services

4 Domain Policies
Application Rules
Border Rules
Media Rules
Security Rules
Signaling Rules

End Point Policy
Groups

Add

Policy Groups.

default-low
default-low-enc
default-med
default-med-enc
default-high
default-high-enc
avaya-deflow-enc
avaya-def-high-subs..

avaya-def-high-server

Filter By Device... v Clone

[tis not recommended to edit the defaults. Try cloning or adding 2 new group instead.

Hover over a row to see its description.
Policy Group

Summary
Order Application Border Media Security Signaling
1 default default avaya-low-med-enc default-low default Edit

Enter an appropriate name in the pop-up box.

Clone Group X

Group Name

Clone Name

avaya-def-low-enc

cpe-def-low-enc

Finish

Highlight the resulting Policy Group and click on Edit (not shown). Enter details as follows:
e Leave the Application Rule, Border Rule, Security Rule and Signaling Rule at their

default values.

e Select the Media Rule created in the Section 6.9.1 in the drop down menu.

e Click on Finish.

Edit Policy Set X

Application Rule
Border Rule
Media Rule
Security Rule

Signaling Rule

default v
default v
cpe-low-med-enc ¥
default-low

default v

Finish
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The completed Policy Group is shown in the following screenshot:

Policy Groups: cpe-def-low-enc

Add Filter By Device... v | Rename || Clone || Delete |

Policy Groups Click here to add a descrpfion.
default-|
stauliiow Click here to add a row description.

Policy Group

Order

default-low-enc

default-med

Summary

default-med-enc

Application
1 default

default-high Signaling

default cpe-low-med-enc default-low default Edit

default-high-enc

avaya-def-low-enc
avaya-def-high-subs. ..
avaya-def-high-server

cpe-def-low-enc

6.10. Server Flows

Server Flows combine the previously defined profiles into two End Point Server Flows, one for
Swisscom Smart Business Connect and the other for IP Office. These End Point Server Flows
allow calls to be routed from IP Office to Swisscom and vice versa. The following diagram,
gives an overview of the Server Flows for the Enterprise (IP Office) and the Service Provider
(Swisscom Smart Business Connect):

Enterprise Flow Service Provider Flow

Server Profile IP/FQDN
URI Group
Transport

Received Interface
Remote Subnet

(Enterprise)
\ T
N . Routing Profile: N\ -
Service Provid
S | Service Frovider Signaling Interface™ — _|
Interface: Media Interface
Server Profile Enterprise

Server Profile
End Point Policy Group
Topology Hiding
Signalling Manipulation

End Point Policy Group
Topology Hiding
Signalling Manipulation

Routing Profile:

Enterprise
L Signaling Interface b
~ \Media Interface Interface: |\ | | “a
N Service Provider N

\ )

{F
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To define a Server Flow for Swisscom Smart Business Connect, navigate to Device Specific
Settings - End Point Flows. Click on the Server Flows tab and click on Add (not shown).
In the Flow Name field enter a descriptive name for the server flow for Swisscom Smart
Business Connect, in the test environment Swisscom was used.
In the Server Configuration field drop-down menu, select the server profile for the
Swisscom network SBC defined in Section 6.6.
In the Received Interface drop-down menu, select the internal SIP signalling interface
defined in Section 6.4.1. This is the interface that signalling bound for Swisscom is

BG; Reviewed:
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received on.

In the Signaling Interface drop-down menu, select the external SIP signalling interface
defined in Section 6.4.1. This is the interface that signalling bound for Swisscom is sent

on.

In the Media Interface drop-down menu, select the external media interface defined in
Section 6.4.2. This is the interface that media bound for Swisscom is sent on.
In the Routing Profile drop-down menu, select the routing profile of IP Office defined in

Section 6.7.

In the Topology Hiding Profile drop-down menu, select the topology hiding profile for
Swisscom defined in Section 6.8 and click on Finish.

Add Flow X

Flow Name

Server Configuration

URI Group

Transport

Remote Subnet

Received Interface
Signaling Interface

Media Interface
Secondary Media Interface
End Point Policy Group
Routing Profile

Topology Hiding Profile
Signaling Manipulation Script

Remote Branch Office

Swisscom

Metwork_SBC v

Internal -

External v

External v

Mone 7

default-low v
IP_Office v

MNetwork v

None ¥

Any ¥

Finish
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To define a Server Flow for IP Office, navigate to Device Specific Settings = End Point
Flows. Click on the Server Flows tab and click on Add (not shown).

In the Flow Name field enter a descriptive name for the server flow for IP Office, in the
test environment IP_Office was used.

In the Server Configuration field drop-down menu, select the server profile for IP
Office defined in Section 6.6.

In the Received Interface drop-down menu, select the external SIP signalling interface
defined in Section 6.4.1. This is the interface that signalling bound for IP Office is
received on.

In the Signaling Interface drop-down menu, select the internal SIP signalling interface
defined in Section 6.4.1. This is the interface that signalling bound for IP Office is sent
on.

In the Media Interface drop-down menu, select the internal media interface defined in
Section 6.4.2. This is the interface that media bound for IP Office is sent on.

If secure media is used within the enterprise, select the End Point Policy Group defined
in Section 6.9 in the drop-down menu. Alternatively, select default-low.

In the Routing Profile drop-down menu, select the routing profile of the Swisscom
network SBC defined in Section 6.7.

In the Topology Hiding Profile drop-down menu, select the topology hiding profile of IP
Office defined in Section 6.8.

Add Flow X

Flow Name IP_Office

Server Configuration IP_Office v

URI Group * v

Transport * v

Remote Subnet *

Received Interface External v

Signaling Interface Internal -

Media Interface Internal *

Secondary Media Interface MNone  r

End Point Policy Group cpe-def-low-enc v

Routing Profile Network_SBC ¥
Topology Hiding Profile CPE v
Signaling Manipulation Scnpt None v
Remote Branch Office Any ¥

Finish
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Click on Finish. The following screenshot shows the completed configuration:

End Point Flows: Portwell46
Subscriber Flows || Server Flows ‘
Portwell46
Add
Click here to add a row description.
r Server Configuration: IP_Office
: End Point :
. _ Received 5 Routing
Prionty Flow Name T (F:olu:y Profile
Group
1 IP_Office * External Internal %’ﬁjﬁg’ Network_SBC View Clone Edit Delete
r Server Configuration: Network_SBC
- - URI Received  Signaling  End Point Routing
FiEil, Ll Lz s Group Interface Interface Policy Group  Profile
1 Swisscom * Internal External default-low IP_Office  View Clone Edit Delete
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7. Configure the Swisscom Equipment

The configuration of the Swisscom Smart Business Connect equipment used to support the SIP
Trunk is outside the scope of these Application Notes and will not be covered. To obtain further
information on Swisscom equipment and system configuration please contact an authorized
Swisscom representative.

8. Verification Steps

This section includes steps that can be used to verify that the configuration has been done
correctly.

8.1. SIP Trunk status

The status of the SIP trunk can be verified by opening the System Status application. A Windows
7 PC was used for testing and the application was opened by pressing the Start button and
selecting All Programs—> IP Office - System Status.

. [P Office . ;
) Devices and Printers
D\ TP Office Knowledge Base
E Manager
&l Monitor
L]
| of System Status S Help and Support
Uninstall IP Office Admin Suite

. Java -

1 Back

Default Programs

Log in to IP Office System Status at the prompt using the Control Unit IP Address for the IP
Office. The User Name and Password are the same as those used for IP Office Manager.

IP Office System Status

Online |offine

Logon

Control Unit IP Address: BURIERTGE

Services Base TCP Port: Ell:=LI1

(T BT H 2dmini strator

Password:

[l Auto reconnect

[l Secure connection

sion 10.1.0.0.0 build 237
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From the left hand menu expand Trunks and choose the SIP trunk (2 in this instance). The status
window will show the status as being idle and time in state if the Trunk is operational.

'ﬁ. — . . .
+J Avaya IP Office System Status - ipo100serv (10.10.4.101) - IP Office Linux PC 10.1.0.0.0 build 237 | = | & R

IP Office System Status

Status | tiization Summary Alarms  Registration

SIP Trunk Summary

Line Service State: In Service

Peer Domain MName: sip:ff192.168.2.19
Resolved Address: 192,168.2,19

Line Mumnber: 2

Mumber of Administered Channels: 30

Mumber of Channels in Use: 0

Administered Compression: G711 A, G711 Mu, G729 A
Enable Faststart: Off

Silence Suppression: off

Media Stream: RTP

Layer 4 Protocol: UDF

SIP Trunk Channel Licenses: 256 . y

SIP Trunk Channel Licenses in Use: 0

SIP Device Features: UPDATE (Incoming and Outgoing)

ive Trans... Trans...

1 Ide [03:43...

m | »

2 Ide |2day...
3 Ide |2day...
4 Ide |2day...
5 Ide |2day...
[
7
8

Ide |2day...
Ide |2day...
Ide |2day... =

Trace [ Trace Al ” Pause ][ Ping ] Call Details Graceful Shutdown ][ Force Out of Service ” Print. ..

14:59:28 Online )

b

Should issues arise with the SIP trunk, use the Avaya SBCE trace facility to check that the
OPTIONS requests sent from IP Office via the Avaya SBCE to the Swisscom Smart Business
Connect network are receiving a response.
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To define the trace, navigate to Device Specific Settings = Advanced Options 2>
Troubleshooting = Trace in the main menu on the left hand side and select the Packet
Capture tab.
e Select the SIP Trunk interface from the Interface drop down menu.
e Select the signalling interface IP address or All from the Local Address drop down
menu.
e Enter the IP address of the network SBC in the Remote Address field or enter a * to
capture all traffic.
e Specify the Maximum Number of Packets to Capture, 1000 is shown as an example.
e Specify the filename of the resultant pcap file in the Capture Filename field.
e Click on Start Capture.

Trace: Portwelld6

Portwell46 Packet Capture Configuration
Status Ready
Interface
Local Address .
IP[:Fort] |A” V| | |
Remote Address |‘
=, *Fort, IF. F:Fort
Protocol Al v
Maximum Number of Packets to Capture
Capture Filename
USIIEQ the name of an existing capture will overwrite it. |S”:‘—T”'I nk—TeSt pcap
| Start Capture | ‘ Clear |

To view the trace, select the Captures tab and click on the relevant filename in the list of traces.

Trace: Portwell46

Packet Capture || Captures ‘
Portwell46
Refresh
File Name File Size (bytes) Last Modified
SIP_Trunk_Test 2017204153607 peap 0 December 4, 2017 34102PM  pejete

The trace is viewed as a standard pcap file in Wireshark. If the SIP trunk is working correctly, a
SIP response to OPTIONS in the form of a 200 OK will be seen from Swisscom.
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9. Conclusion

All tests for Swisscom Smart Business Connect were completed. Observations for the testing are
listed in Section 2.2.
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10. Additional References
Product documentation for Avaya products may be found at http://support.avaya.com.
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